
 Worksheets 

1. Know about the Computer

A. State whether the following statements are true or false.

 1. The output unit displays the processed information to the user.

 2. Dot Matrix Printer works very similar to a keyboard.

 3. An inkjet printer produces hard copy by spraying ink onto a paper.

 4. Control unit manages the activities of peripherals.

 5. Secondary memory is volatile.

B. Choose the correct answer.

 1. Which printer uses dry ink to produce hard copy?

 (a) Inkjet printer

 (b) Laser printer

 (c) Dot matrix printer  

 (d) Colour printer

 2. Which of the following is true for OMR?

 (a) Takes normal printed or hand written text as input

 (b) Creates a digital image of the text

 (c) Recognises the darkened circles

 (d) Used to convert books and documents into electronic files

 3. Which of the following is not an example of secondary memory?

 (a) RAM

 (b) Pen drive

 (c) Optical disk

 (d) Magnetic tape

 4. Which of the following checks the validity of bank cheques?

 (a) OCR

 (b) OMR

 (c) Barcode reader  

 (d) MICR

 5. Which of the following is not true for a computer?

 (a) A computer consists of four functionally independent main parts.

 (b) All the operations are coordinated by the ALU.



 (c) Memory unit stores program data.

 (d) The information that is less frequently accessed is kept in primary memory.

C. Match the following.

  Column A    Column B

 1. Logic instructions   (a) Main memory

 2. Arithmatic instructions  (b) Permanent memory

 3. Control unit   (c) AND, OR, NOT, XOR 

 4. Secondary memory   (d) Addition, Multiplication, Division,
      Subtraction 

 5. Primary memory   (e) Extracts instructions from memory
      decodes and executes them

D. Fill in the blanks.

 1. A computer is a combination of ___________ and ___________ components.

 2. Instructions or data given to the computer by the user are either stored in the ___________ 
or immediately used by the ___________ to perform the desired operation.

 3. Whenever a key is pressed, one corresponding word or number is ___________ into its 
equivalent ___________ code over a cable and fed into the ___________ or ___________.

 4. OMR sheet has circles that need to be filled with a dark ___________ or ___________.

 5. Magnetic Ink is a special ink that contains particles of ___________.

E. Answer the following questions.

 1. Differentiate between Dot Matrix printer, Laser printer and Inkjet printer.

 2. Describe CPU in detail.

 3. Illustrate the organisation of computer components.

 4. Enlist the advantages of a computer.

 5. Write a short note on memory unit.



Answers to Worksheet

A. 1. True 2. False 3. True 4. True 5. False
B. 1. (b) 2. (c) 3. (a) 4. (d) 5. (c)
C. 1. (c) 2. (d) 3. (e) 4. (b) 5. (a)
D. 1. hardware, software   2. memory, processor
 3. translated, binary, memory, processor 4. pencil, ink 5. iron oxide
E. 1. Dot Matrix Printer Laser Printer Inkjet Printer

It works very similar to a typewriter 
and creates the impression by 
striking on the paper.

An inkjet printer produces 
hard copy by spraying ink 
onto a paper.

A laser printer uses 
laser beam and dry ink 
to produce hard copy.

It produces output in black and 
white.

It produces output both 
in black and white, and in 
colour.

It gives a very high 
quality output.

 2. The Central Processing Unit (CPU) is the brain of a computer where the processing of input 
data is done. The CPU consists of two components.

 • Arithmetic Logic Unit (ALU): It performs arithmetic and logic operations. Arithmetic 
instructions include addition, subtraction, multiplication, division while logic instructions 
include AND, OR, NOT and XOR operations.

 • Control Unit (CU): It is a piece of hardware that manages the activities of peripherals. It 
extracts instructions from memory, decodes and executes them.

 3. Program and Data

Central Processing Unit
Control Unit

Arithmetic 
Logic Unit

Input Unit Memory Unit Output Unit

 4. Few advantages of a computer are as follows.

 • It stores large amount of data.

 • It performs tasks at a high speed.

 • It performs calculations quickly and accurately.

 • It does repeated work with same speed and accuracy.
 5. Memory unit stores program data. Memory unit consists of two types of memory—primary 

memory and secondary memory. Primary memory is also called main memory. This memory 
is directly accessed by the CPU for reading and storing. Primary memory is further divided 
into two types—Read Only Memory (ROM) and Random Access Memory (RAM). Secondary 
memory is used to store large amount of data and programs. It is also called permanent 
memory because it is non-volatile. The information that is less frequently accessed is kept in 
secondary memory. Magnetic disks and tapes, optical disks and pen drive are a few examples 
of secondary memory.



2. Types of Software and Computer Languages

A. State whether the following statements are true or false.

 1. A computer cannot operate without a software.

 2. A computer software manages and controls the hardware so that application software can 
perform required tasks.

 3. The most important system software is the operating system.

 4. 5GLs  are designed to reduce the level of programming efforts.

 5. When a computer is switched on, the first program that is loaded in the memory is the Text 
editor.

B. Choose the correct answer.

 1. A/an _____________ is a program that enables a computer to interact with the hardware 
devices.

 (a) driver   (b) diagnostic tool

 (c) compiler   (d) assembler

 2. An/a _____________ translates a program line by line, passing each line to the CPU for 
execution before the next line is interpreted.

 (a) compiler (b) assembler (c) translator (d) interpreter

 3. The _______________ translates a complete program at once before passing it on to the 
CPU.

 (a) assembler (b) compiler (c) translator (d) interpreter

 4. An _______________ is generally used for hardware programming.

 (a) compiler (b) assembler (c) translator (d) interpreter

 5. ________________ occupies low memory and is very fast as it is executed directly by CPU.

 (a) Binary code   (b) Machine language

 (c) Compiler   (d) Assembler

C. Match the following.

  Column A    Column B

 1. C++   (a) High speed of execution 

 2. Cold Fusion   (b) Programming software

 3. Artificial intelligence   (c) Compiler, interpreter and assembler

 4. Text editor   (d) High level language 

 5. Translator   (e) Fifth generation language



D. Fill in the blanks.

 1. ____________ is a program that translates a set of instruction codes to machine level 
language.

 2. Computer understands ____________ language only.

 3. Instructions are given in the form of ____________.

 4. Machine language is also considered as ____________ language.

 5. A program written once in high level language can be run on different types of ____________.

E. Answer the following questions.

 1. How is second generation language different from third generation language?

 2. Describe the classification of system software.

 3. Write a brief note on fifth generaion languages.

 4. Differentiate between system software, application software and programming software.

 5. What is the purpose to develop fourth generation languages?



Answers to Worksheet

A. 1. True 2. True 3. True 4. True 5. False
B. 1. (a) 2. (d) 3. (b) 4. (b) 5. (b)
C. 1. (d) 2. (a) 3. (e) 4. (b) 5. (c)
D. 1. Language translator 2. machine   3. binary digits
 4. low level   5. processors
E. 1. Second Generation Language Third Generation Language

Second generation language (2GL) refers 
to the assembly language. This language 
uses mnemonic codes or symbols 
instead of 0 and 1.

Third generation language (3GL) refers to a 
high level language. A high level language is 
simple to learn, write and understand, and is 
very similar to the English language.

Computer understands only machine 
language, so assembler converts 
assembly language into machine 
language. Since programming in this is 
time consuming, it is also considered as a 
low level language.

Program written once in high level language 
can be run on different types of processors 
but needs to be translated into machine 
language by translator programs. Compiler 
and interpreter are the two types of translators 
used.

For example, 0010 means ADD in binary 
language, but in assembly language it is 
directly written as ‘ADD’

Basic, C, C++ and COBOL are some examples 
of high level languages.

 2. 
System Software

Device Drivers Language TranslatorsOperating System

 • Operating System: The most important system software is the operating system. When a 
computer is switched on, the first program that is loaded in the memory is the operating 
system. It act as an interface between the user and the hardware. Windows, Linux and Mac 
OS are some popular operating systems.

 • Device Drivers: A driver is a program that enables a computer to interact with the hardware 
devices like printer and pen drive.

 • Language Translators: Language translator is a program that translates a set of instruction 
codes to machine level language. There are three types of translators: compiler, interpreter 
and assembler.

 3. Fifth generation language (5GL) is the language used in the field of artificial intelligence. It 
is designed to reduce the level of programming efforts. Here the users specify the required 
output they want, while the computer determines the sequence of instructions that will 
accomplish those results. Thus, scientists are trying to develop artificial intelligence in 
computers so that they can think and take decisions themselves. 



 4. System Software Application Software Programming Software

System software refers to 
the programs designed to 
control the operation of 
a computer system. It is a 
computer software which 
manages and controls 
the hardware so that 
application software can 
perform required tasks.

An application software allows 
the users to perform one or 
more specific tasks without 
having any knowledge of 
computer programming. 
Application software includes 
programs that do specific work 
for a user. 

A programming software 
allows the programmer 
to develop a program for 
computer application.

System software are further 
classified into operating 
system, device drivers and 
language translators.

Word Processor, Spreadsheet 
and PowerPoint are some 
application software.

Text editors and 
diagnostic tools are some 
programming software.

 5. The purpose of fourth generation languages (4GLs) is to reduce programming time, effort 
and cost by offering different methods of generating code automatically from a simpler 
framework. It has a very high speed of execution.



3. More on Flowcharts

A. State whether the following statements are true or false.

 1. Algorithm helps to understand the logic of a system better.

 2. Problems can be analysed in a more effective way using a flowchart.

 3. Program acts as a guide or blue print during the system analysis and program development 
phase.

 4. Flowchart becomes simplified if the program logic is complicated.

 5. Flowchart has to be completely redrawn in case of alterations.

B. Complete the given flowcharts by writing the instructions and drawing the missing 
symbols.

 1. Read A, B
S = A + B
D = A – B
P = A × B

Print S, D, P_______ Stop

 2. 
Take an 

umbrella

Leave umbrella 
at home

Start

_______

____

No

Is it 
raining?

 3. 

Stop

Start

Input A, B

Both numbers 
are equal

Is

A = B
____

No Yes

Yes

Is
A > B

?

A is ____
than B

A is ____
than B



C. Fill in the blanks.

 1. ___________ is a step-by-step procedure to solve a particular problem.

 2. Computer follows a set of predefined instructions given by the user. This set of instructions is 
called ___________.

 3. A flowchart is a pictorial representation of steps of an _______________ used for solving a 
particular problem.

 4. In a flowchart, each operation is represented by a ________________________ connected by 
arrows.

 5. Flowchart serves as good program ___________________.

D. Answer the following questions. 

 1. Read the given flowchart and answer the following questions.

 (a) Is the flowchart correct? If no redraw the correct flowchart.

 (b) What does the above flowchart depict?

 (c) Write down the output for the following input.

  (i) –10  (ii) 72  (iii) –6

 2. Complete the given table.

 Symbol Name Function

Start/Stop An __________ is used to indicate the beginning and 
the end point

Input/Output
A __________ is used to indicate the acceptance 
of input from the user or the output or the result 
concluded.

Arrows
A __________ is a connector that connects various 
geometrical shapes. The arrow's direction represents 
the flow of the sequence

Process A __________ represents steps involving processing 
of data

Decision Box A __________ represents steps involving a decision 
to be taken on the basis of a specific condition

Connector A __________ is a circle which connects one part of a 
flowchart to another

 3. What information is conveyed through a flowchart?

 4. How is branched flowchart different from looping flowchart?

 5. Differentiate between algorithm, flowchart and a program.

Input C_temp

Output F_temp

F_temp = 
(1.8°C_temp) 

+ 32

Start

Stop



Answers to Worksheet

A. 1. False 2. True 3. False 4. False 5. True

B. 1. StopRead A, B
S = A + B
D = A – B
P = A × B

Print S, D, PStart

 2. 
Take an 

umbrella

Leave umbrella 
at home

Start

Stop

Yes

No

Is it 
raining?

 3. 

Stop

Start

Input A, B

Both numbers 
are equal

Is

A = B
No

No Yes

Yes

Is
A > B

?

A is smaller
than B

A is greater
than B

C. 1. Algorithm 2. program 3. algorithm 4. specific geometric shape
 5. documentation
D. 1. (a) No

  

Output F_temp

Start

Stop

Input C_temp

F_temp = (1.8*C_temp) + 32



  (b) The given flowchart depicts the conversion of temperature in Celcius scale to Farenheit 
scale.

  (c) (i) -10°C
   = [1.8 * (-10)] + 32
   = -18 + 32
   = 14 °F
   (ii) 72°C
   = [1.8 * 72] + 32
   = 129.6 + 32
   = 161.6 °F
   (iii) -6°C
   = [1.8 * (-6)] + 32
   = -10.8 + 32
   = 21.2 °F
 2. Oval, parallelogram, line, rectangle, diamond, connector
 3. A flowchart conveys the following information.

• Sequence in which steps should be performed

• Steps involved in obtaining user input or giving an output

• Steps to be repeated

• Different conditions involved in handling the process

• Steps describing the processing of data

 4. Branched Flowchart Looping Flowchart

Sometimes the flow of steps in an 
algorithm can branch into multiple paths 
based on how a particular condition works 
out. Branching is the process of following 
one or two or more alternate paths of 
computations.

Sometimes few steps in an algorithm have 
to be repeated for a specifi c number of 
times. This is known as a loop. A loop is 
the sequence of instructions that repeats a 
specified number of times until a particular 
condition is met.

 5. Algorithm Flowchart Program

Algorithm is a 
step-by-Step 
procedure to 
solve a particular 
problem.

A flowchart is a pictorial representation 
of steps of an algorithm used for solving 
a particular problem. In a flowchart, each 
operation is represented by a specific 
geometric shape connected by arrows.

Computer follows a set of 
predefined instructions 
given by the user. This set 
of instructions is called 
program.



4. Introduction to MS Small Basic

A. State whether the following statements are true or false.

 1. A string is always enclosed within single quotes.

 2. Constants are the variables whose value change during the execution of a program.

 3. Operators are the symbols used to perform various operations on variables or constants.

 4. A string contains a sequence of characters, 0–9 and special symbols like % ? , # etc.

 5. Relational operators compare two values and return True (1) or False (0).

B. Choose the correct answer.

 1. ____________________ combine two or more relational expressions and return the result as 
True or False.

 (a) Logical operator   (b) String constants

 (c) Variables   (d) Statements

 2. ____________ are the reserved words in programming.

 (a) Strings constants   (b) Variables

 (c) Keywords   (d) Statements

 3. Which of the following is true for Writeline ( ) statement?

 (a) The text written within the double quotes is printed as it is. It shifts the pointer to the 
next line after printing the message.

 (b) It makes the pointer stay on the same line after printing the message.

 (c) It only takes string value as input.

 (d) It can be either an integer or floating type.

 4. Which of the following is true for Writeline ( ) statement?

 (a) The text written within the double quotes is printed as it is. It shifts the pointer to the 
next line after printing the message.

 (b) It makes the pointer stay on the same line after printing the message.

 (c) It only takes string value as input.

 (d) It can be either an integer or floating type.

 5. Which of the following is a Keyword?

 (a) Math. Min (N1, N2)

 (b) Read ( ) and Read Number ( )

 (c) EndSub

 (d) AND



C. Match the following.

  Column A  Column B

 1. AND (a) It gives the absolute value of a number.

 2. OR (b) It returns the value of Pi.

 3. Math. Min (N1, N2) (c) It returns ‘True’ only if both the relational
    expressions are ‘True’.

 4. Math. Pi (d) It returns ‘True’ if at least one of the
    relational expressions is ‘True’.

 5. Math. Abs (N) (e) It compares two numbers and returns the smallest
    of the two numbers.

D. Fill in the blanks.

 1. Microsoft Small Basic has inbuilt __________________ which can perform all the calculations.

 2. Every instruction in Small Basic is called a _____________.

 3. Every instruction follows certain set of rules called _____________.

 4. A _____________ is a location in a computer memory that is used to store data temporarily.

 5. A _________________ contains a list of characters.

E. Answer the following questions.

 1. Differentiate between logical operators and relational operators.

 2. Write a short note on statements.

 3. Differentiate between the types of constants.

 4. Describe Math Library Functions

 5. Write a detailed note on variables.



Answers to Worksheet

A. 1. False 2. False 3. True 4. False 5. True
B. 1. (a) 2. (c) 3. (a) 4. (b) 5. (c)
C. 1. (c) 2. (d) 3. (e) 4. (b) 5. (a)
D. 1. Math Library functions 2. statement   3. syntax
 4. variable   5. string variable
E. 1. Logical Operators Relational Operators

Relational operators compare two 
values and return True (1) or False (0).

Logical operators combine two or more relational 
expressions and return the result as True or False.

AND, OR are the logical operators >, <, =, <=, >= and <> are the relational operators

 2. Every instruction in Small Basic is called a statement.
�� Writeline ( ) and Write ( ): Writeline ( ) statement is used to write a line of text in a window. 

The text written within the double quotes is printed as it is. It shifts the pointer to the next 
line after printing the message. Write ( ) statement works very similar to writeline ( ). It 
makes the pointer stay on the same line after printing the message.

�� Read ( ) and Read Number ( ): Read ( ) statement reads the line of text from the window. It 
only takes string value as input. Read Number ( ) statement reads the numeric value. It can 
be either an integer or floating type.

 3. 

  
Numeric Constant String Constant

A numeric constant contains integer values. 
It can either be positive or negative. 

A string constant contains a sequence of 
characters, 0–9 and special symbols like % ? 
, # etc. within double quotes. 

224, –7.4 and +12 are some examples. “RAM” and “+61432” are some examples.

 4. Small Basic provides Math Library that contains various functions to perform mathematical 
calculations. Following are the different functions used in Small Basic. 

Function Purpose Example Result

Math. Min (N1, N2) It compares two numbers and returns 
the snallest of the two numbers

Math. Min 
(10, 5)

5

Math. Max (N1, N2) It compares two numbers and returns 
the greatest of the two numbers.

Math. Max 
(10, 5)

10

Math. Remainder 
(N1, N2)

It gives the remainder when two 
numbers are divided.

Math. 
Remainder 

(10, 5)

0

Math. Abs (N) It gives the absolute value of a number. Math. Abs 
(–42.23)

42.23

Math. Pi It returns the value of Pi. Math. Pi 31,4159



 5. A variable is a location in a computer memory that is used to store data temporarily. There are 
some rules that need to be followed while naming a variable.

• The first character of the variable name should be a letter, followed by any letter, digit or 
underscore character. For example, B, B2 and B–4 are some valid names.

• String variable names should have $ symbol as the last character. NAME$ and A–1$ are 
some examples.

  There are two types of variables.
  Numeric Variable: A numeric variable holds only the numeric value. Numeric variables are 

further divided into the following.

• Integer Type: This type holds only integer values. It does not contain any decimal point. 56, 
78 and –9876 are some examples.

• Floating Type: It holds a value that contains a decimal point. 78.98 and –54.8 are some 
examples.

  String Variable: A string variable contains a list of characters. A string is always enclosed within 
double quotes, within these quotes it can be either a number or characters. “Basic” and “1 2 3 
4 5 6” are some examples.



5. More on PowerPoint

A. State whether the following statements are true or false.

 1. Charts simplify the process of comparison.

 2. A sound can also be recorded and added to a presentation.

 3. The ability to move objects, text and charts on the slide is called transition.

 4. Exit effect controls the manner in which an object exits from the slide during the slide show.

 5. The way one slide follows the other on the screen is called animation.

B. Complete the steps.

 1. Changing background, colours and patterns

  __________-click on the Chart Area and select the ______________________ option from the 
list. A ‘Format Chart Area’ dialog box appears. Click on the ______________ icon. Select the 
fill border, colour and other desired options. Click on the __________ icon. Select the desired 
effect. Click on the ____________________ icon. Select the size, position and alternate text 
of your choice.

 2. Adding video

  Click on the Insert tab. Click on the ____________ in the ‘Media’ group of the ____________ 
tab. A drop-down menu appears. Select the Video on ____________ option. An ‘Insert 
Video’ dialog box appears on the screen. Select the desired video file and then click on the 
____________ button. The Format and Playback tabs appear. You can format the inserted 
video by clicking on the ____________ tab. Click on the Play ____________.

 3. Editing chart data

  Select the chart. The __________ tab for the chart appears. Click on the ____________ button 
in the ‘Data’ group. The ___________ containing the data opens on the screen. Edit data in 
the spreadsheet. The chart in the __________ displays the changes made in the data of the 
_______________.

C. Match the following.

  Column A  Column B

 1. Insert tab (a) Alignment group

 2. Table Styles group (b) Arrange group 

 3. View Gridlines (c) Ribbon 

 4. Text Directions (d) Draw Table option 

 5. Arrange Text (e) Table group



D. Fill in the blanks.

 1. A __________ is used to organise the information in a tabular format.

 2. Columns are vertical series of cells whereas rows are __________ series of cells.

 3. The __________ tab is used to format a table.

 4. _______________ (Table Group) shows or hides the gridlines in the table.

 5. Charts are an effective way to display data in a __________ form.

E. Answer the following questions.

 1. Write steps to apply transition effect to a presentation.

 2. Describe the options under Layout tab to modify the table.

 3. Enlist the steps to apply border on the table.

 4. Write a note on animation.



Answers to Worksheet

A. 1. True 2. True 3. False 4. True 5. False
B. 1. Right, Format Chart Area, Fill & Line, Effects, Size & Properties
 2. Video button, Insert, My PC, Insert, Format, button
 3. Design, Edit Data, spreadsheet, slide, spreadsheet
C. 1. (c) 2. (d) 3. (e) 4. (a) 5. (b)
D. 1. table 2. vertical, horizontal 3. Design
 4. View Gridlines   5. pictorial
E. 1. • Select the slides to which transition effect is to be applied. Click on the Transitions tab. 

Select the desired option from the ‘Transition to This Slide’ group.
• You can also add sound to your slide by clicking on the drop-down arrow of the Sound 

button in the ‘Timing’ group. Select the sound of your choice.
• You can specify the duration of the transition in the ‘Duration’ box of the ‘Timing’ group.
• To apply the transition to all slides, click on the Apply to All button present in the ‘Timing’ 

group.
• To select how to advance a slide, select On Mouse Click or After option from ‘Advance Slide’. 

You can advance a slide automatically after a few seconds.
• To preview the transition of the current slide, click on the Preview button in the ‘Preview’ 

group of the ‘Transitions’ tab.
 2. The Layout tab provides the following options to modify a table.

• View Gridlines (Table Group): It shows or hides the gridlines in the table.
• Insert Rows and Columns (Rows & Columns Group): It inserts rows and columns above, 

below, left and right of the current column.
• Delete Tables, Rows and/or Columns (Rows & Columns Group): It deletes table, rows and 

columns.
• Merge or Split Cells (Merge Group): It merges or splits the selected cells.
• Increase or Decrease Cell Size (Cell Size Group): It sets the height and width of the selected cell.
• Align Text, Text Directions, Cell Margins (Alignment Group): It aligns the text within the 

cells, changes text direction and specifies the margin for the selected cell.
• Fix the Height and Width (Table Size Group): It sets the width and height of the table.
• Arrange Text (Arrange Group): It arranges the text of the table.

 3. • Select the rows or columns to be modified. Click on the drop-down arrow of the ‘Borders’ 
tool in the ‘Table Styles’ group. Select All Borders option. Borders will be applied on the 
selected rows and columns.

 4. The ability to move objects, text and charts on the slide is called animation. Using animation, 
multiple pages can be displayed rapidly in a sequence such that the images appear to be in 
motion. Following are the different categories of animation effects.
• Entrance: This effect decides the manner in which an object enters a slide during the slide 

show. It makes the object focus, fade, etc.
• Emphasis: This effect makes an object shrink or grow in size, change colour, etc.
• Exit: This effect controls the manner in which an object exits from the slide during the slide show.
• Motion paths: This effect make an object move up or down, left or right, etc.



6. MS PowerPoint: Giving Presentations

A. State whether the following statements are true or false.

 1. PowerPoint allows you to record a narration for the slide show.

 2. As we record narration, PowerPoint stores slide files separately so that the slides are 
synchronised with the narrations recorded by us.

 3. Speaker notes or notes pages allow creating notes for each slide.

 4. Slides should be of consistent design throughout the presentation.

 5. The text under bullets should be long sentences.

B. Fill in the blanks.

 1. The _____________ group on the Slide Show tab contains many options for the slide show.

 2. The Set Up Slide Show option is available in the __________ group of _____________ tab.

 3. Set Up Slide Show option allows you to set _____________ on how the slide show will be 
presented.

 4. Using Rehearse Timings feature, we can save timing for each ________ and _____________.

 5. _____________ or _____________ are the notes added to the slides as a reference for the 
speaker.

C. Answer the following questions.

 1. Write the groups and tabs for the following.

 (a) Spelling button   (b) From Beginning button

 (c) Notes Page option   (d) Rehearse Timings option

 2. Enlist the tips for an effective presentation.

 3. Write the steps to perform the following tasks.

 (a) To run a slide show

 (b) To check spelling errors

 (c) To rehearse timings

 (d) To record narration

 4. Describe the options Set Up Show window includes.



Answers to Worksheet

A. 1. True 2. True 3. True 4. True 5. False
B. 1. Slide show   2. Set Up, Slide Show 3. preferences
 4. slide, animation  5. Speaker notes, notes pages
C. 1. (a) Review tab, Proofing group
  (b) Slide Show tab , Start Slide Show group
  (c) View tab, Presentation Views group
  (d) Slide Show tab, Set Up group
 2. While designing and running a presentation, keep the following points in mind.

• Slides should be of consistent design throughout the presentation.

• Use high-quality graphics and pictures to make the presentation attractive.

• Remove unnecessary information from the presentation.

• Use contrasting background and text colours.

• Limit bullet points and text. Do not use more than six bullets per page.

• Limit to three fonts for the text in a presentation.

• Use consistent fonts throughout the presentation.

• The text under bullets should be short ideas, not long sentences.

• Add web links to your presentation and use hyperlinks between the slides.

• Prepare the introduction and conclusion.
 3. (a) • To start the slide show, click on the From Beginning button or the From Current Slide 

button of the ‘Start Slide Show’ on the ‘Slide Show’ tab.
   • Use the arrow keys on the keyboard to move forward or backward in a presentation. 

Press the Escape (Esc) key to end the slide show.
  (b) • Click on the Review tab. Click on the Spelling button in the ‘Proofing’ group.
   • A ‘Spelling’ box appears on the right side of the slide. Change the spelling or ignore the 

suggested changes.
  (c) • Click on the Rehearse Timings option from the ‘Set Up’ group of the ‘Slide Show’ tab.
   • You will be taken to a full screen view of the presentation. Practise speaking and 

advance the slides as required in the presentation.
   • Click on the Next button on the ‘Recording’ toolbar in the upper-left corner.
   • When you reach the end of the show, a dialog box appears displaying the total time of 

your presentation. Click on the Yes button if you are satisfi ed with the timing.
  (d) • Click on the Record Slide Show option from the ‘Set Up’ group of the ‘Slide Show’ tab. 

It will give two options Start Recording from Beginning and Start Recording from 
Current Slides.

   • Click on any one of the options. Click on the Start Recording button.
   • Speak in the microphone when the ‘Recording’ dialog box appears on the screen.
   • To stop recording, click on [×] button. Total time of the slide show is displayed on the 

left button on the screen.



 4. Set Up Show window includes many options like Show type, Show slides, Show options, 
Advance slides and Multiple monitors.

• Show type: It allows to configure the presentation for one of the three basic slide show 
types: Presented by a speaker (full screen), Browsed by an individual (window) or Browsed 
at a kiosk (full screen).

• Show options: To run the show indefinitely until you press Esc, select the Loop continuously 
until ‘Esc’ check box. You can also run a show with or without narration.

• Pen color: It selects the pen colour to be used.

• Laser pointer color: It selects the colour of the laser pointer.

• Show slides: To include all slides in the slide show, select All or choose From and enter 
starting and ending slide numbers if you want to display just some slides in the slide show.

• Advance slides: You can choose to change the slides manually by pressing the Enter key 
or by clicking on the slide. To set the show to proceed automatically, select Using timings, 
if present.

• Multiple monitors: This option is used to select the monitor from the drop-down list in the 
‘Multiple monitors’ area if the computer has two monitors.



7. The Mail Merge

A. State whether the following statements are true or false.

 1. The data is organised in a tabular form with the field names.

 2. Directory is used to print a catalogue that requires printing multiple records per page.

 3. We cannot check whether Microsoft Word has picked up the data source same as we had 
typed.

 4. After merging of the Main Document and the Data Source is done, we can complete the mail 
merge procedure.

B. Complete the given steps.

 1. To preview merged data

  Click on the Preview Results button on the _________________ group of the ____________ 
tab. The first record will be displayed. Click on the ______________ button to view the 
remaining ____________.

 2. To finish and merge

  Click on the Finish & Merge option in the ____________ group of the ____________ tab. A 
drop-down list appears. Click on the ________________________ option. A ____________ 
____________ dialog box appears. Select the All option and click on the ________ button.

 3. To print letters

  Click on the Finish & Merge button in the _________ group of the ___________ tab. A drop-
down list appears. Click on the Print Documents option. The ________________ dialog box 
appears. Define the desired _________ settings and click on the OK button.

 4. To insert record fields

  Place the cursor where you want to insert the record fields. Click on the Insert Merge Field 
button in the __________________ group of the _________ tab. The ‘Insert Merge Field’ 
dialog box appears with the list of field names. Click on the field name and click on the 
_________ button. After inserting all the fields, click on the Close button. To separate the 
field names in a document, press the _________ key.

 5. To create a new recipient list

  Select the Type a new list radio button under _______________. Click on the Create option. 
A _______________ dialog box will appear on the screen. Click on the _______________ 
button to add or remove fields. Enter the data in the fields and click on the ___________ 
button. Click on the ______ button. ______________ dialog box appears. Specify a name in 
the ‘File name’ box. Click on the _________ button. The ‘Mail Merge Recipients’ dialog box 
appears. To change any detail, click on the _________ button. Click on ______ button. Click 
on the __________________ option.



C. Fill in the blanks.

 1. The body of the letter which contains the text to be sent to all recipients is called the 
_________________.

 2. Data Source consists of a _______________.

 3. The Data Source is combined with the _________________ so that the field names can be 
used in the _________________.

 4. Mail merge reads the data source and _____________ merges it with the main document to 
generate ___________ for all the records found in the data source.

 5. ____________ is used for composing and designing multiple documents for which only the 
____________ information varies.



Answers to Worksheet

A. 1. True
 2. True
 3. False
 4. True

B. 1. Preview Results, Mailings, Next Record, records

 2. Finish, Mailings, Edit Individual Documents, Merge to New Document, OK

 3. Finish, Mailings, Merge to Printer, print, 

 4. Write & Insert Fields, Mailings, Insert, Close, Enter

 5. Select recipients, New Address List, Customize Columns, New Entry, OK, Save Address List, 
Save, Edit, OK, Next: Write your letter

C. 1. Main Document

 2. mailing list

 3. Main Document, Main Document

 4. physically, letters

 5. Letter, recipient



8. More on Microsoft Word 2016

A. State whether the following statements are true or false.

 1. The space between lines and paragraphs can either be increased or decreased.

 2. Symbols can also be formatted in a document.

 3. Symbols can be selected from Word’s Symbol dialog box.

 4. We cannot add text or picture as a watermark in the document using the Custom Watermark 
option.

 5. To edit the equation, we click on the Equation.

B. Complete the given steps.

 1. To apply watermark to a document

  Click on the Design tab. Click on the _____________ option in the ________________ group. 
A drop-down list appears. Select the watermark of your choice. It will be applied to the 
____________ document.

 2. To insert equations

  Place the cursor in the document where you want to insert the equation. Click on the 
___________ tab. Select the ___________ option from the _______ group. Select the 
Equation button from the ___________ group. A drop-down menu appears. Select the 
appropriate ___________ structure or click on the Insert New Equation option. If you select 
an equation structure, the required equation will be inserted in the document.

 3. To insert symbols and special characters

  Place the cursor in the document where you want to insert the symbol. Click on the _________ 
tab. Select the Symbols option from the _________ group. From the drop-down menu, select 
the appropriate symbol from the ___________ group. If your required symbol is not shown, 
click on the _______________ option. The ‘Symbol’ dialog box appears. Select the required 
symbol and click on the ________ button.

C. Fill in the blanks.

 1. A footnote is placed at the bottom of a ___________.

 2. An endnote is placed at the _______ of a ___________.

 3. ___________ are signs or special characters that can be inserted in a document.

 4. Watermark refers to an ___________ or ___________ which is shown as a faded ___________ 
behind the text in a document.

 5. The purpose behind using a watermark is to avoid ___________.

D. Answer the following questions.

 1. Write the tabs for the following groups.

 (a) Footnotes group (b) Paragraph group (c) Illustrations group

 (d) Text group (e) Page Background group

 2. Why are footnotes and endnotes used?



Answers to Worksheet

A. 1. True
 2. True
 3. True
 4. False
 5. True

B. 1. Watermark, Page Background, entire

 2. Insert, Symbol, Test, Symbols, equation

 3. Insert, Text, Symbol, More Symbol, OK

C. 1. page

 2. end, document

 3. Symbols

 4. image, text, imprint

 5. duplicacy

D. 1. (a) Reference tab

  (b) Home tab

  (c) Insert tab

  (d) Insert tab

  (e) Design

 2. Footnotes and endnotes are used by the author to provide details like bibliographical 
information, copyright information and explanatory information. The footnote is used in a 
document to give comments or references for the text. The endnote is used to give references 
for the sources of the text.



9. Formulae and Functions

A. State whether the following statements are true or false.

 1. The relational operators are used to compare two values. They give the result in true or false.

 2. The arithmetic operators perform calculations only with numeric values.

 3. The logical operators are used to compare two or more relational expressions.

 4. The logical operators give the result in true or false.

 5. If the formula in A3 is = A1 + A2 and you copy the same formula to B3, then Excel automatically 
changes the cell address in the formula.

B. Choose the correct answer.

 1. What is the formula for simple interest?

 (a) P*R*T/100

 (b) P+R+T/100

 (c) P-R-T/100

 (d) 100/P*R*T

 2. In _________, the formula in the copied cell changes according to the change in the position 
of the cell pointer.

 (a) absolute reference   (b) relative reference

 (c) mixed reference   (d) functions

 3. An absolute reference is specified using the _______ sign along with the column and row 
number of the cell.

 (a) #   (b) @

 (c) $   (d) *

 4. Identify the mixed reference from the following.

 (a) = $B2*$

 (b) = B2*C$2

 (c) = B2*C2

 (d) = $B2*C$2

 5. ________________ are the predefined commands that act on a cell or a range of cells and 
perform calculations.

 (a) Functions

 (b) Reference

 (c) Statements

 (d) Programs



C. Match the following.

  Column A  Column B

 1. LCM (a) Returns the largest value in the given range

 2. Sum (b) Returns the smallest value in the given range 

 3. Average (c) Returns the least common multiple of integers 

 4. Max (d) Returns the sum total of the range values 

 5. Min (e) Returns the average of the range values 

D. Fill in the blanks.

 1. A formula in Excel begins with an equal to _____ sign.

 2. The function consists of two parts: the _______________ and the ____________.

 3. The arguments are included within the _________________.

 4. To get AutoSum, click on the AutoSum button in the ________________ group on the 
__________ tab.

 5. Excel provides all its functions in the _______________ group of the __________ tab.

E. 1. Describe the types of cell referencing.

 2. Write a note on function library.

 3. Enlist the rules to use a function.

 4. Enlist some common error results displayed in Excel.

 5. What does data in a formula consist of?



Answers to Worksheet

A. 1. True 2. True 3. True 4. True 5. True
B. 1. (a) 2. (b) 3. (c) 4. (d) 5. (a)
C. 1. (c) 2. (d) 3. (e) 4. (a) 5. (b)
D. 1. (=)   2. function name, arguments
 3. round brackets   4. Function Library, Formulas
 5. Function Library, Formulas
E. 1. There are three types of cell referencing in Excel.

• Relative Reference: In relative reference, the formula in the copied cell changes according 
to the change in the position of the cell pointer. For example, if the formula in A3 is = A1 + 
A2 and you copy the same formula to B3, then Excel automatically changes the cell address 
in the formula.

• Absolute Reference: An absolute reference is specified using the $ sign along with the 
column and row number of the cell. For example, $8$4 is an absolute reference. The 
purpose of $ sign is fixed to a specific location. This type of referencing is used when we 
do not want to change the address of the cell while copying the formula to another cell.

• Mixed Reference: Mixed reference is a combination of relative reference and absolute 
reference. In this type, either the row or column has to remain fixed. $B4 is an example of 
mixed reference.

 2. Excel provides all its functions in the Function Library group of the Formulas tab. Excel 
includes the functions like Math and Trig, Text and Data & Time. 
• LCM function returns the least common multiple of integers.
• GCD function calculates the greatest common divisor of two or more integers.

 3. Following rules should be followed while using a function.
• A function must begin with an equal to (=) sign.
• A function name must be a valid name. Sum and Average are some examples.
• A function name must be followed by opening and closing parenthesis.
• Arguments should be enclosed in the parenthesis.

 4. Following are some common error results displayed.
• # N/A: Data is not available.
• # VALUE!: The formula contains an invalid operation.
• # DIV/0!: Division by zero is being performed.
• ####: The column is not enough to display the number.
• #NAME?: The Excel does not recognise the text in a formula.

 5. The data in a formula consists of any of the following.
• Value: String or numeric
• Cell address: A1, B4 and so on
• Functions: MAX, MIN, SUM and more
• Operators: +, –, *, / and more
• Parenthesis: ( )



10. Adobe Flash Professional CS6

A. State whether the following statements are true or false.

 1. Ink is used to draw freehand lines with modifications.

 2. Smooth is used to draw smooth and curved lines.

 3. Paint Bucket tool is used to fill colour in an object.

 4. Eraser tool is used to erase anything drawn on the Stage.

 5. Ink Bottle tool is used to change properties like stroke colour and angle.

B. Choose the correct answer.

 1. Flash files have an extension _________.

 (a) .fla (b) .flh (c) .flx (d) .fls

 2. By default, the ______________ size is 550 × 400 pixels.

 (a) image (b) stage (c) panel (d) work area

 3. Timeline Panel is divided into frames.

 (a) panels (b) stages (c) timeline (d) frames

 4. The _________________ is a collection of tools that are used to perform activities.

 (a) Tools Panel   (b) Property Inspector

 (c) Menu Bar   (d) Work Area

 5. Straighten is the default mode for ______________________ tool.

 (a) Paint Bucket (b) Pencil (c) Pen (d) Brush

C. Complete the following steps.

 1. To draw a curve

  Click on the _________ tool on the ‘Tools Panel’ and draw a line. Click on the _________ tool 
on the ‘Tools Panel’. Move the pointer or the line. When _________ shape changes, click and 
drag the line to draw the curve. Release the mouse button when the _________ is drawn.

 2. To import an image

  Click on the _________ menu. Click on the Import option. Select the _____________ option. 
An ‘Import’ window appears. Select the _________ from where you want to import the 
image and select the _________. Click on the _________ button. The file gets imported to 
the _________.

 3. To draw thick lines

  Click on the _________ tool in the ‘Tool Panel’. Select the brush _________ and brush 
_________ from the ‘Tools Panel’. Drag the mouse on the Stage to draw lines. 

 4. To draw precise paths in the form of straight lines or curves

  Click on the _________ tool on the ‘Tools Panel’. Click on the Stage to define _________ and 
_________ at a distance. _________-click on the last point to complete the path. Select the 
_________ colour and _________ from the ‘Property Inspector’ dialog box.



 5. To draw lines on the Stage

  Click on the _________ tool in the ‘Tools Panel’. In the ‘Property Inspector’ dialog box, select 
the desired _________ colour and _________ style. Click and drag in the direction where you 
want to draw a line. Release the mouse button. A line will be drawn on the Stage.

D. Fill in the blanks.

 1. Rectangle tool is used to draw ______________ and ______________ shapes.

 2. Pen tool is used to draw precise paths in the form of ______________ or ______________.

 3. The ______________ and ______________ of the segment can be adjusted afterwards.

 4. Text tool is used to type text on the ______________.

 5. Brush tool is used to draw ______________ lines.

E. Answer the following questions.

 1. Explain the different modes of Eraser tool.

 2. Describe the three possible modes of Pencil tool.

 3. Differentiate between Lasso tool, Free Transform tool and Selection tool.



Answers to Worksheet

A. 1. False 2. True 3. True 4. True 5. False
B. 1. (a) 2. (b) 3. (d) 4. (a) 5. (b)
C. 1. Line, Selection, pointer's curve
 2. File, Import to Stage, location, file, Open, stage
 3. Brush, size, shape
 4. Pen, point A, point B, Double, stroke, height
 5. Line, stroke, line
D. 1. square, rectangular 2. straight lines, curves
 3. angle, length   4. Stage
 5. thick
E. 1. Eraser tool is used to erase anything drawn on the Stage. It has five different modes.

• Erase Normal: It erases all the lines over which the tool is dragged.

• Erase Fill: It erases only the filled area of an object and the outlines remain unaffected.

• Erase Selected Fills: It erases the selected part of an object.

• Erase Lines: It erases the strokes without affecting the fills.

• Erase Inside: It erases only the area of filled part of an object.
 2. The Pencil tool has three possible modes: Straighten, Smooth and Ink.

• Straighten: It is the default mode. It automatically straightens the line drawn by the Pencil 
tool.

• Smooth: It is used to draw smooth and curved lines.

• Ink: It is used to draw freehand lines with no modifications. 
3.

 

Lasso Tool Free Transform Tool Selection Tool

Lasso tool selects the 
Irregular area of the 
drawing.

Free Transform tool is 
used to scale, rotate and 
skew any object in Flash.

The Selection tool is 
used to select a single or 
multiple objects on the 
Stage and to change the 
straight line into curve.



11. More about the Internet

A. State whether the following statements are true or false.

 1. A message that we send using the Internet passes through several networks before reaching 
the recipient.

 2. Communication can be processed through instant messaging, e-mail or video conferencing.

 3. Network connects computers and the users of those computers.

 4. Networking allows easy sharing of information and resources.

 5. A network is a system that provides its users with unique capabilities.

B. Choose the correct answer.

 1. A network in an office building, school or home usually contains a single _______________.

 (a) LAN   (b) MAN

 (c) WAN   (d) network

 2. Cable network is an example of _______________.

 (a) MAN   (b) WAN

 (c) LAN   (d) network

 3. _______________ is an example of WAN.

 (a) Client   (b) Server

 (c) Internet   (d) Data sharing

 4. A device that transmits packets of information between the ________ and the ________ is 
called a router.

 (a) client, server   (b) LAN, WAN

 (c) WAN, MAN   (d) LAN, MAN

 5. A __________________ finds the best path to send information between the computers.

 (a) LAN   (b) router

 (c) MAN   (d) WAN

C. Match the following.

  Column A  Column B

 1. Google Duo (a) SonyLIV

 2. Viber (b) Chat application 

 3. E-commerce (c) Video conferencing application 

 4. Internet TV (d) Voice and video calls 

 5. Yahoo Messenger (e) Ebay.com 



D. Fill in the blanks.

 1. Internet is a ____________ of networks.

 2. A ________________________ connects network devices over a country and covers a larger 
area than that of MAN.

 3. ________________________ connects the computers of the same or different cities.

 4. ________________________ connects network devices over a short distance and is managed 
by a single person or organisation.

 5. Networking facilitates the sharing of _______________ devices.

E. Answer the following questions.

 1. Differentiate between LAN, WAN and MAN.

 2. Define the following terms.

 (a) Chat

 (b) Video conferencing

 (c) P2P

 (d) Server

 (e) Clients

 3. What is a computer network?

 4. What are the benefits of a computer network?

 5. Write a brief note on netiquette.



Answers to Worksheet

A. 1. False 2. True 3. True 4. True 5. True
B. 1. (a) 2. (a) 3. (c) 4. (a) 5. (b)
C. 1. (c) 2. (d) 3. (e) 4. (a) 5. (b)
D. 1. network 2. Wide Area Network (WAN) 3. Metropolitan Area Network (MAN)
 4. Local Area Network (LAN) 5. hardware

E.
 

1.
 

LAN WAN MAN

Local Area Network (LAN) 
connects network devices 
over a short distance and is 
managed by a single person or 
organisation.

A Wide Area Network 
(WAN) connects network 
devices over a country 
and covers a larger area 
than that of MAN.

Metropolitan Area 
Network (MAN) connects 
network devices over a 
city and covers a larger 
area than that of LAN. 

A network in a office building, 
school or home usually 
contains a single LAN.

Internet is an example of 
WAN.

Cable network is an 
example of MAN.

 2. (a) Chat is a text-based communication between two or more users. A chat is a short message 
that enables other participants to respond quickly.

  (b) Video conferencing is a form of communication that includes exchange of audio and 
video at the same time between people sitting at geographically separate locations.

  (c) When we use a chat program to send instant messages, our computer acts as a server 
as we send message and as a client when we receive it. This is called peer-to-peer 
communication (P2P).

  (d) A computer that provides the required information or acts as storage is called server.
  (e) The computers that get the requested information are called clients.
 3. A computer network is a group of computers linked to each other through wired medium or 

a wireless medium. A network is a system that provides its users with unique capabilities.
 4. • Connectivity: Network connects computers and the users of those computers.
  • Data sharing: Networking allows easy sharing of information and resources.
  • Device sharing: Networking facilitates the sharing of hardware devices. For example, 

multiple users can share a single hardware device like a printer.
  • Communication: The communication can be processed through instant messaging, e-mail 

or videoconferencing.
 5. Netiquette are the set of rules to be followed while using the Internet.
  • Never reveal your address, phone number or any other personal information to a stranger 

in a chat room. There is a chance that he/she may not be the person he/she is claiming to be.
  • Never agree to meet an online friend alone. If you go to meet a person, take an elder with 

you and arrange to meet at a public place like a park or a mall.
  • All information available on the Internet is not correct. So, verify the information through 

multiple sources before using it.


